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DISPOSAL OF TANK FARM LONG-LENGTH CONTAMINATED EQUIPMENT:
LLCE CHARACTERIZATION SOFTWARE FUNCTIONAL CRITERIA AND
MANAGEMENT PLAN

1.0 INTRODUCTION
1.1 PURPOSE

The purpose of this plan is to develop software that will be used with the Flexible
Receiver Radiation Detection System (FRRDS) to provide the radionuclide and chemical
inventory of Long Length Contaminated Equipment (LLCE) retrieved from underground waste
storage tanks. The LLCE radionuclide/chemical inventory data will be used to generate waste
characterization data to support preparation of waste shipping documents.

1.2 SCOPE

Two software programs will be developed to provide LLCE waste characterization
support. These programs will be written using Microsoft Visual Basic' and will be designed to
run on a IBM-AT? compatible computer using the Microsoft Windows® 3.1 operating system.

The LLCE Characterization database program will maintain a database of all tank waste
characterization data, LLCE physical data, and regulatory data used for LLCE waste
characterization. It’s purpose will be to prepare a characterization data file for the LLCE
being retrieved and to save that information for reuse in subsequent LLCE retrievals. It's
primary output will be a data file that will be generated for each LLCE prior to LLCE
retrieval. This data file will be required by the LLCE waste characterization analysis
program. The program will be designed so that all data in the database can be reviewed and
changed as regulations change or more current tank waste data becomes available.,

The LLCE waste characterization analysis program is the second program to be
developed. It will calculate the chemical/radionuclide inventory of the LLCE being retrieved.
It's three main functions will be as follows:

Visual Basic is a trademark of Wilson WindowWare, Inc., Seattle, WA.
IBM-AT is a trademark of the International Business Machines Corporation
*Windows is a trademark of Microsoft Corporation
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. Interface with the microVAX computer that operates the gamma assay detectors on
the FRRDS. This interface is accomplished by the transfer of the FRRDS gamma
assay data through a data disk produced by the microVAX control computer.

. Analyze the raw gamma assay data produced by the FRRDS. The total content of
all measured gamma radioisotopes will be calculated for the LLCE. These
numbers will be corrected for LLCE geometry to produce the final content
numbers.

. The measured gamma radioisotopes will be ratioed against the tank waste content
data to produce a total radionuclide/chemical inventory estimate for the LLCE.
The radionuclide/chemical inventory estimates will be used to generate waste
characterization data to support preparation of waste shipping documents.

1.3 OVERVIEW

The Long Length Contaminated Equipment (LLCE) disposal effort involves developing
a standard process for retrieval, handling, and disposal of LLCE from any one of the 177
underground waste storage tanks, catch tanks, and lift stations. These tanks contain
radionuclides and EPA/WDOE RCRA listed wastes. The LLCE in contact with this waste
will be characterized as Low Level Waste (LLW), Low Level Mixed Waste (LLMW), or TRU
mixed Waste (TRUM) when retrieved dependant on the success of the water rinse and the
content of the waste tank.

When LLCE are retrieved from the tanks every effort is made to remove any residual
tank waste that is on the equipment surfaces. It is expected that a small amount (thin layer) of
tank waste will remain on the LLCE after retrieval. The radionuclide and chemical content of
this residual layer must be assessed to determine the proper waste designation, handling, and
disposition requirements for the LLCE.

The flexible receiver assembly was developed as part of project W-151 and will also be
used for the standard LLCE disposal process that is currently being developed. The software
development, which is the subject of this plan, is in support of this overall standard LLCE
disposal process development effort. The flexible receiver assembly performs several
functions. It maintains containment of the LLCE during retrieval, allows video inspection of
exterior LLCE surfaces after water rinse, and performs a gamma assay of the LLCE as it’s
being retrieved. The FRRDS is a subsystem of the flexible receiver assembly which provides
the gamma assay function.

Disposal of Tank Farm Long-Length Contaminated Equipment: Radiological and
Chemical Characterization Plan, WHC-SD-WM-TCP-007, was written to document how the

2
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FRRDS generated gamma assay data will be used to determine the radionuclide/chemical
content of the LLCE. In addition this plan contains procedures for determining the waste
designation and support information for a LLCE waste package. This software development

will develop computer programs that will implement the LLCE waste characterization
procedures in the radionuclide and chemical characterization plan.

1.4 DELIVERABLES
The following shall be developed and will be completed by 9/30/96.

. LLCE waste characterization database program software and associated databases.

. LLCE waste characterization analysis program software.
. Software acceptance test plan and acceptance test report.
. The user manual for this software will be developed in FY97.

2.0 SOFTWARE DESCRIPTION
2.1 GENERAL DESCRIPTION

The software developed with this plan will be written in Microsoft Visual Basic and will
be Windows 3.1 based applications. User input will be made in on-screen forms and dialog
boxes. Every attempt will be made to make these programs as user friendly as possible.

One purpose of having two separate programs to perform the LLCE waste
characterization function is to allow for control of data. It is anticipated that only authorized
personnel will be assigned the responsibility to use the LLCE characterization database
program and to generate the characterization data file required by the LLCE waste
characterization analysis program. The LLCE waste characterization analysis program can be
used the field when the LLCE is being retrieved. The field user will not be able to change
tank waste characterization data without access to the LLCE characterization database
program.
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2.2 WASTE CHARACTERIZATION DATABASE PROGRAM

The databases maintained by the LLCE characterization database program will be in
Microsoft* Access 2.0 format. This data will be directly accessed and managed by the LLCE
characterization database program. Description and structure of the databases is documented
in Appendix A.

This program will maintain databases of variable data that is used to perform waste
designation and characterization of the LLCE. Much of the data in this database will not
change frequently. It will track tank waste characterization data, LLCE physical data,
physical constants, and various regulatory limits. The program will allow the user to view,
update data (if required), and to provide hard copy of the database. In addition this program
will be used to prepare a characterization data file that is specific for the LLCE and waste tank
that the LLCE is retrieved from. This data file will provide data required to the LLCE waste
characterization analysis program.

The program will maintain an audit file which will track the use of the program and will
record the date any of the databases are changed.

The sections that follow outline the data tha. will be maintained by the database
program.

2.2.1 Tank Waste Characterization Data

This will contain the radionuclide/chemical content data for all of the 177 underground
waste storage tanks. The initial database will have the most up to date data that can be
obtained for the waste tanks. However, given the current state and change in tank waste
characterization information, it is essential that this data be reviewed prior to LLCE retrieval
and updated if more accurate or current data is available.

Up to ten layers of tank waste may be defined for each tank. Each layer may have a
different waste composition. Different units may be used as long as they are consistent for all
chemical and radionuclide entries for a tank. If more than one tank waste layer is defined for
a tank the user must manually input data for the tank waste content of all layers. In addition
the thickness and relative position of each tank waste layer must be defined. If more than one
tank waste layer is defined the program user will be prompted to enter the distance from the
bottom of the waste tank to the bottom tip of the LLCE. This is necessary to relate the
different tank waste layers to the gamma assay data.

“Microsoft is a trademark of Microsoft Corporation
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When there is more than one tank waste layer defined weighted averages will be used to
determine the content of the tank waste at each one foot section of the LLCE.

Any data that is changed or added will be saved to the database and will become the
default for that waste tank the next time the data is accessed.

2.2.2 LLCE Physical Data and Description

Physical data for all currently defined LL.CE will be maintained by the program. The
user will enter the drawing and part number for the LLCE being retrieved. If the drawing
number is recognized the program will retrieve the current description, overall diameter,
length, required waste container size, and weight of LLCE from the database. If the LLCE
drawing number is not recognized the program will ask the user to enter physical data for the
new LLCE. Physical data may be edited and changed as necessary.

Any data that is changed or added will be saved to the database and will become the
default for the LLCE the next time the data is accessed.

2.2.3 LLCE Geometry Correction Factors

These factors must be calculated for a LLCE the first time the LLCE is retrieved. The
Nuclear Physics and Shielding group is responsible for preforming this required analysis. The
waste generator is responsible to contract with the Nuclear Physics and Shielding group to
conduct this analysis. Very few LLCE have been analyzed to determine their geometry
correction factors. These few LLCE will have the geometry correction factors predefined at
the time of initial database creation. For all other LLCE, the Default correction factors will
be 1.0 unless changed by the user. However, using the default (1.0) correction factors will
result in inaccurate radionuclide content estimates.

The geometry correction factors will be calculated for one foot increments along the
length of the LLCE. A different factor will be determined for each measured gamma isotope
for each one foot increment of length.

The Nuclear Physics and Shielding group may be able relate previous calculations to
new LLCE if the new LLCE is very similar in geometry to LLCE previously analyzed. It will
be their responsibility to make this call. At Ieast 2 to 3 months prior to LLCE retrieval should
be allowed for the Nuclear Physic and Shielding group to complete this analysis.

Any data that is changed or added will be saved to the database and will become the
default for the LL.CE the next time the data is accessed.
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2.2.4 LLCE Waste Container Data

This data will not change unless changes are made to the design of the waste containers.
Physical data for the nine (9) LLCE waste containers will be predefined in the database. This
will include Container OD, 1D, length, maximum allowable LLCE length, maximum
allowable LLCE diameter, tare weight, drawing number(s), internal volume, external volume,
skid drawing number(s), and skid weight.

The program will automatically select the proper waste container size based on the
LLCE selected for retrieval. However, the program user will be able to override this selection
if another container size will be used for some reason.

Although this data will rarely change (if ever), the user will be allowed to view, edit,
and produce hard copy of the data. Any data that is changed will be saved to the database and
will become the default the next time the data is accessed.

2.2.5 Radionuclide Constant Data

This data will not generally change unless a new radionuclide needs to be added to the
list. However, all data can be reviewed, edited, and hard copy of the database may be made if
necessary. The following data will be tracked for each radionuclide:

. Radionuclide atomic weight and element name

. Radionuclide specific activity

. Radionuclide half life

. Daughter isotopes and branching ratios
. Radioactive emission type : alpha, beta, gamma or x-ray
. If the radionuclide is fissile or TRU isotope

. Radionuclide heat generation (W/Ci)
2.2.6 Radionuclide Regulatory Limits Data
This data will not generally change unless there is a change in regulatory limits.

However, all data can be reviewed, edited, and hard copy of the database may be made if
necessary. The following data will be tracked for each radionuclide:

6
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. Radionuclide atomic weight and element name

. Category 1 LLW limit (Ci/m3)

. Category 3 LLW limit (Ci/m3)

. NRC Class C limit (Ci/m3)

. Category 3, noncombustible waste limit (Ci/m3)

. PE-Ci correction factor for TRU waste

. Pu-239 FGE correction factor for TRU waste

. DOT A2 limit curies

. WHC-EP-0063-4 A2 limit curies

. CWC Curie limit per waste package

. DE-Ci factor (Ci/Ci)

. Current SARP limit in curies

. DOvE/NRC 741 reporting unit (grams)
2.2.7 Chemical Regulatory Limits Data

This data will track the D004-D011 waste code limits. The D004-D011 waste code
limits are the mg/L limits for heavy metals. These limits are specified in the current WAC
173-303-090(8)(C). If the waste concentration for these heavy metals exceeds the established
limits then the LLCE waste will be characterized with the applicable ‘D’ waste code. These
code limits can be changed if necessary.
2.2.8 Setup Data

This data will contain the list of valid measurable gamma isotopes. The list of valid

measurable gamma isotopes is the list of gamma isotopes that will be considered valid when
evaluating the FRRDS gamma assay data. This list of gamma isotopes can be changed if
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necessary. Isotopes can be added or deleted. A hard copy report of this data can be
produced.

2.2.9 Audit File Data

This data will provide an audit trail on the use of the characterization database program.
It will maintained automatically by the program and will contain the following information:

. Program user name
. Date of program use
. Characterization data file name

. LLCE Description , LLCE Drawing and part number
. Tank and tank riser LLCE retrieved from

. Last revision date for databases: TANKCHAR.DB, LLCEPHYS.DB,
LLCEGEOM.DB, LLCECONT.DB, LLCENUC.DB, RADREG.DB,
CHEMREG.DB, and LLCESET.DB

2.3 LLCE WASTE CHARACTERIZATION ANALYSIS PROGRAM

The LLCE waste characterization analysis program will be a windows based program
written in Microsoft Visual Basic. All user entry will be made in on screen forms and dialog
boxes. This program can be used in the field at the time the LLCE is retrieved or in the office
after LLCE retrieval. Incomplete (missing data) entry of data forms will be permitted. All
data input up to the time of normal program exit will be saved. Successful data analysis will
not be possible until all required data have been input. The program will notify the program
user if data is missing and the user attempts to do characterization analysis with incomplete
data. During the normal startup of the LLCE characterization analysis program, the program
user will be asked if this program run is for an existing or new LLCE retrieval. With an
existing LLCE retrieval all data saved for the previous program run will be retrieved and the
data entry forms will be filled with the existing data. At this point the user can complete data
entry or change previous data entry and rerun the analysis of the LLCE. Selecting new
analysis is for new LLCE retrievals (all forms are blank). The program user must enter a
name for any new LLCE retrieval. This name will be used to create a file to store all user
input data.
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Two external data files are required by this program. The characterization data file
generated by the LLCE characterization database program must be specified. The other data
file required is the raw gamma assay data file generated by the FRRDS. A windows based file
dialog box will simplify the task of specifying the file name and path for these files.

The program will require the program user to specify the LLCE being retrieved by
drawing number and part number, the tark and tank number for the tank the LLCE is being
retrieved from, and the riser number the LLCE is being removed from. This information will
be used to verify that the LLCE characterization data file is correct for this LLCE retrieval,
The program user will be required, at the time of LLCE retrieval, to enter the crane position
(ft) at the time the LLCE riser flange is visible using the video system for the flexible receiver
internal view window. This will relate the arbitrary crane position reading to actual position
or location on the LLCE. In addition the program user will be required to input weight data
for the LLCE and the flexible receiver bag and lifting dunnage. After this input is complete
LLCE waste characterization analysis can be completed.

The following sections describes the three main functions of the LLCE waste
characterization analysis program.

'2.3.1 FRRDS Data Interface

The interface from the FRRDS system will be in the form of a ASCII encoded data file
recorded on a MSDOS® formatted disk. This file will be transferred from the FRRDS
microVAX control computer onto a floppy disk and that disk will be physically placed into a
disk drive in the computer system running the LLCE characterization analysis software. The
format of the data file is documented in Appendix C. A description of the FRRDS provided
software and software function is documented in Appendix B.

The gamma assay data file will contain multiple gamma inventory results for the LLCE,
The FRRDS system acquires a spectrum for the LLCE at approximately one minute intervals.
Since the LLCE is retrieved at one foot per minute this spectrum will cover an approximate
one foot section of the LLCE. If the LLCE is re-lowered for re-rinsing during retrieval
subsequent gamma inventory records may supersede prior inventory records and must be
accounted for by the software. Position tracking for the inventory records is possible since
each record is stamped with the current crane position in feet. At each position where data is
acquired , data is acquired from each of the three independent detectors. Total gamma isotope
inventory for that section of the LLCE must be interpreted from the readings of the three
detectors. If the surface dose rate of the LLCE becomes excessive one or more of the

*MSDOS is a trademark of the Microsoft Corporation
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detectors will become saturated and no record will be generated by those detectors while they
are non-functional. If All detectors are non-functional gamma assay data will be missing for
that section of the LLCE.

Some of the gamma radionuclides reported in the data file will be phantoms or ghosts
that will have some reported activity but in reality are non-existent. The list of valid measured
gamma radionuclides will be maintained by the LLCE characterization database program. All
other measured radionuclides will be ignored.

Once the LLCE is retrieved an existing microVAX program “AVR2" must be run on the
FRRDS microVAX control computer. This program generates the ASCII encoded gamma
assay data file that is read by the LLCE waste characterization analysis program.

2.3.2 FRRDS Gamma Assay Data File Analysis

The first main analysis function performed by the program, after successful data input,
is to analyze the raw FRRDS generated data to estimate the total measured gamma isotope
content of the LLCE waste. The first step is to-reconcile all of the multiple and conflicting one
foot length gamma inventory records to determine the measured gamma isotope content for
each one foot segment of the LLCE. Next geometry correction factors are applied to the
measured gamma isotope content for each one foot section of the LLCE. Once the geometry
correction factors have been applied the total measured gamma isotope inventory for the LLCE
can be calculated.

Where multiple tank waste layers are defined the total measured gamma isotope content
will be calculated for each section of the LLCE in the different tank waste layers.

If the surface dose rate of the LLCE becomes excessive the FRRDS will not produce
gamma assay data for these areas. When the program detects this condition the program user
is notified of the problem and is told which sections of the LLCE is missing gamma assay
data. It will be the program users responsibility to determine by other means what the gamma
content estimates should be for these areas. The program will prompt the program user to
manually enter the missing inventory data.

2.3.3 Radionuclide/Chemical Content and Characterization Support Data

The characterization analysis program will use the total measured gamma isotope content
estimates along with the tank waste characterization data to calculate the total radionuclide and
chemical data inventory for the LLCE that is retrieved. In addition the program will calculate
characterization support data in accordance with the procedures in Disposal of Tank Farm
Long-Length Contaminated Equipment: Radiological and Chemical Characterization Plan,

10
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WHC-SD-WM-TCP-007. The LLCE waste characterization analysis program will calculate
the following data to support preparation of shipping papers for the LLCE waste:

Estimate of total radionuclide content for LLCE waste package
Estimate of total Chemical content for LLCE waste package
Sum of fractions for Category 1 LLW

Sum of fractions for Category 3 LLW

Sum of fractions for NRC Class C

Sum of fractions for TRU

Flag if the TRU fraction exceeds the established suspect TRU limit or regulatory
TRU limit of 100 nCi/g

Waste category based on radionuclide content and sum(s) of fractions
Calculate Plutonium Equivalent Curie (PE-Ci) (for TRU)

Flag if PE-Ci exceeds 35 PE-Ci limit for TRU waste

Calculate Pu-239 Fissile Gram Equivalent (FGE)for TRU waste
Calculate total alpha curies for waste package for TRU waste

Determine if waste package contains accountable materials

Determine the heat generation rate for the waste package

Flag if waste package heat generation rate exceeds 3.5 W/m® (0.1 W/ft%)

Determine transportation category (LSA, Limited Quantity, Type-A, Type-B,
HRC) according to DOT A2 limits

Determine transportation category according to A2 values limits in WHC-EP-
0063-4, Appendix L

11
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. Determine if any CWC curie limits in WHC-EP-0063-4, Appendix L, for waste
package are exceeded

. Calculate CWC Dose Equivalent Curie (DE-Ci), if WHC-EP-0063-4, Appendix L,
calculated transportation Category > A or CWC curie limits in WHC-EP-0063-4,
Appendix L, are exceeded

. Flag if criticality safety analysis required **U > 15 g)

. Determine if any limits established for the LLCE waste package SARP has been
exceeded

. Generate summary of recommended hazardous waste codes for waste package

The program user will be able to print a summary report or detailed reports for all the
calculations made by the program.

2.4 ASSUMPTIONS AND DEPENDENCIES

An assumption must be made that the FRRDS system is fully operational prior to an
LLCE retrieval. The FRRDS is an independent system that provide data necessary for LLCE
waste characterization. The LLCE waste characterization software is dependent on this proper
operation of this system.

These programs will be designed to be run on any IBM-PC compatible running the
Windows 3.1 operating system. It is assumed that this PC will have 2 minimum of 8
megabytes of ram and at least 50 megabytes of free disk space to accommodate the program
files and data files required by these programs.

3.0 SPECIFIC REQUIREMENTS
3.1 FUNCTIONAL REQUIREMENTS

This section describes the functional requirements for the software that will be developed
according to this plan.

3.1.1 General Requirements
3.1.1.1 The programs will be a Windows 3.1 based programs capable of running on any

IBM-AT compatible that uses the Windows 3.1 operating system has 8 megabytes
total ram and 50 megabyte of free disk space.
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Data entry will be by Windows based on screen forms and dialog boxes.

Standard Windows File Open, Save, and Print, dialog boxes will be used with this
program.

Error checking will be conducted by the program. The following ways will be
used to implement error checking:

. Where a valid range exists for a data entry point the user input will be
checked against this range.

. Data input will be checked for proper format. For example where numbers
are expected only numbers will be allowed.

. Lists will be presented to the user for the entry of some data. For example
the program will have the user select from a list of valid tank farms (A,
AX, AP, etc) to select the tank farm. In turn once the tank farm is selected
the user will select from a list of valid tank numbers for that farm to specify
which tank in the farm the LLCE is being retrieved from.

. Subroutines in program will have error handling routines to handle expected
errors. Message boxes will inform the user when an error has occurred and
will provide error recovery information. This information will also be
recorded in a text error report file.

Program selections that are inappropriate at different points in the program will be
greyed out (disabled) or invisible to the user.

All Data entered or changed by the user will be saved to a file name selected by
the program user.

Hard copy reports of all input data and analysis results can be produced.

3.1.2 LLCE Characterization Database Program

3.1.2.1

This program will maintain a database of all data required for the characterization
of all LLCE. The data that will be tracked is defined in section 2.2 of this plan.
This includes tank waste characterization data, LLCE physical data, LLCE
geometry correction factors, and regulatory limits and physical constants for
radionuclides and chemicals.
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The program will be designed to take the program user step by step through the
process of generating the characterization database file. However, the program
user will not be constrained to follow this program order.

The program will produce a data file that contains the tank waste characterization
data, LLCE physical data, LLCE geometry correction factors, and LLCE waste
container data that is specific for the LLCE that is identified for retrieval and to
the waste tank the LLCE is being retrieved from. Physical constants and
regulatory limit data is also part of this data file but is not specific to any
individual LLCE. This data file is required by the LLCE waste characterization
analysis program.

For the tank waste characterization data:

Up to 10 different waste layers can be defined. All layers may have a
different waste composition.

Multiple tank waste layers shall be defined starting from the bottom most
layer in the waste tank. Waste layer specific gravity (SpG) and thickness
shall be defined for each layer.

The list of different radionuclides and chemicals in the database is derived
from the list of radionuclides and chemicals that exist in the current Tank
Waste Information Network System (TWINS) Tank Waste Characterization
Database (TCD). Radionuclides or chemicals in the database can be added
or deleted from the database. The user will be asked to define all of the
properties for the new radionuclide or chemical. Units must be consistent
for entering tank waste content data for a tank.

All existing data can be reviewed, edited, and hard copy reports may be
made of the database. If data is added or changed in the database the audit
file will note that the date the database was changed.

Units for entry of radicnuclide content data may be in total curie content
(i.e. Ci), curie content per unit volume (i.e. Ci/m’), or curie content per unit
mass(i.e. Ci/g). Unit volume can be in m® or cm®. Unit mass can be in kg
or grams.

Units for entry of chemical content data may be in total mass content (i.e.

grams), or mass per unit volume (i.e. g/L*). Mass can be in kg or grams.
Volume can be in m’, cm?®, or liters.
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3.1.2.5 For the LLCE physical data and description data:

All known LLCE will be predefined in the initial database. There are
currently over 581 existing LLCE identified. New LLCE can be entered
into the database or existing data can be edited.

When the program user inputs the drawing and part number for the LLCE
being retrieved, the program will check this against the current list of
existing LLCE. If it exists in the database the program will automatically
bring in the current physical data for the LLCE. If the drawing number is
not recognized the program will assume this is a new LLCE and will require
the program user to input data for the LLCE. The program will try to check
for mistyped drawing numbers. The program user always has the option of
printing out the LLCE database to check a hard copy list of current LLCE.

All data can be reviewed, edited, and hard copy report can be made. Any
data that is changed will be saved to the database and will become the
default data for the LLCE. If data is added or changed in the database the
audit file will note that the date the database was changed.

If more than one tank waste layer is defined for the LLCE being retrieved,
the program user must input distance from the bottom of the waste tank to
the bottom most tip of the LLCE.

3.1.2.6 For the LLCE geometry correction factors:

.

This will be keyed to the drawing number of the LLCE that the program
user has specified for retrieval.

The geometry correction factors shall be entered for each one foot section of
the LLCE starting from the bottom of the LLCE. A geometry correction
factor will be entered for each valid gamma radionuclide for each one foot
section of the LLCE. Defauit value will be 1.00 for all valid gamma
isotopes unless changed by the program user.

All data entered will be saved and can be reused the next time that LLCE is

specified for retrieval. If data is added or changed in the database the audit
file will note that the date the database was changed.
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All existing LLCE geometry correction factors that have been calculated
will be entered into the database at the time of initial database creation.

3.1.2.7 For radionuclide constant data:

The database will contain the radionuclide constants listed in section 2.2.5 of
this plan.

All data that is changed or added will be saved for reuse of data the next
time the program is run.

All data can be reviewed, edited, and hard copy report can be made.

3.1.2.8 For the radionuclide regulatory limits data:

The database will contain the radionuclide regulatory limits listed in section
2.2.6 of this pian.

All data that is changed or added will be saved for reuse of data the next
time the program is run. If data is added or changed in the database the

audit file will note that the date the database was changed.

All data can be reviewed, edited, and hard copy report can be made.

3.1.2.9 For the chemical regulatory limits data:

The database will contain the chemical regulatory limits listed in section
2.2.7 of this plan.

All data that is changed or added will be saved for reuse of data the next
time the program is run. If data is added or changed in the database the

audit file will note that the date the database was changed.

All data can be reviewed, edited, and hard copy report can be made.

3.1.2.10 For the LLCE waste container data:

The database will contain the LLCE waste container data listed in section
2.2.4 of this plan
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The program will automatically retrieve the LLCE waste container data
based on the drawing number entered by the program user for the LLCE
being retrieved. The program user will be able to override the default
container selection if another LLCE container size is used.

All LLCE container data can be reviewed, edited, and hard copy report can
be made. If data is added or changed in the databasc the audit file will note
that the date the database was changed.

All data that is changed or added will be saved for reuse of data the next
time the program is run.

For the LLCE setup data:

The database will contain the valid measured gamma assay radionuclide list
and the suspect TRU limit as described in section 2.2.8 of this plan

Data can be added, reviewed, edited, and hard copy report can be made. If
data is added or changed in the database the audit file will note that the date
the database was changed.

All data that is changed or added will be saved for reuse of data the next
time the program is run.

User input to the LLCE characterization database program will be made in the
following order:

At start up of LLCE characterization database program the program user
will be prompted to select either a new or existing program run. If existing
program run is selected the program user will specify the name of the
existing input file. All input data will be input from the existing file into the
program. The program user can then change the existing input information
and re-create the LLCE characterization data file. If new program run is
selected the program user will be prompted to enter a filename that will be
used to store user input to the program . A standard Window’s file dialog
box can be used to assist the program user in selecting the file path and file
names.

The program user will enter the drawing and part number for the LLCE

being retrieved and the tank farm and tank number the LLCE is being
retrieved from. The program will verify that the numbers are valid.
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. After the LLCE drawing number, tank farm, and tank and tank riser number
have been entered the program will present the program user with a logical
step by step progression through the program. The program user will not be
constrained to follow this program order. The Program user can review,
verify, and edit the tank waste characterization data, LLCE physical data,
LLCE geometry correction factors, LLCE waste container data, and
regulatory limits and physical constants in any order.

. After all data entry is complete and characterization data has been reviewed
the LLCE characterization database file can be created.

3.1.3 LLCE Waste Characterization Analysis Program

3.1.3.1

3.1.3.2

This program will calculate the radionuclide and chemical content of an LLCE that
is retrieved from anyone of the 177 underground waste storage tanks, catch tanks,
and lift stations.

User input will be in this order:

. At start up of LLCE waste characterization analysis program the program
user will be prompted to either open existing analysis file or to start new
analysis.

. Selecting existing analysis will read in data saved from a previous session of

the program. All existing data will be retrieved and data entry forms will be
filled with existing data. Existing data can be changed or missing data can
be entered to allow data analysis to be completed.

. Selecting new analysis will start the program with empty forms. If new
analysis is selected the program user will enter a name for the analysis run.
This name will be used to create a file to save the data entered during this
session.

. With a new analysis, the program user will enter the full path and file name
for the LLCE characterization database file created for the LLCE being
retrieved. A standard Windows file dialog box can be used to assist the user
in supplying this information

. With a new analysis, the program user must enter the full path and file name
for the FRRDS generated gamma assay data file created for the LLCE
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during retrieval. A check will be made when the FRRDS data file is read to
determine if the last date on in the FRRDS file matches the LLCE pull date
entered by the program user. If there is a miss match in dates the program
will flag the difference to the program user. The program user will need to
determine if the wrong retrieval date or FRRDS file name was specified. A
standard Windows file dialog box can be used to assist the user in supplying
this information

The program user will enter the drawing and part number of the LLCE
being retrieved and the tank farm ar'l tank number the LLCE is being
retrieved from. The program will verify that the LLCE information entered
matches the LLCE data specified in the LLCE characterization database file.

The program user will enter the tank riser number the LLCE is being
retrieved from.

The program user shall enter the arbitrary crane reading (ft) at the time the
LLCE riser flange is visible in the video view window that inspects exterior
LLCE surfaces.

The program user shall enter the weight of the LLCE, lifting dunnage, and
flexible receiver bag. The weight of the individual components may be
entered separately or the combined weight of all three may be entered. If a
crane mounted dynamometer is used the combined weight can be taken from
the dynamometer just after the LLCE has been retrieved from the tank and
is free hanging on the crane. This assumes that the crane mounted
dynamometer has sufficient accuracy.

The program user shall enter the LLCE retrieval date.

The following data will be input to the LLCE waste characterization analysis
program by reading a data file generated by the LLCE characterization database
program as described in section 3.1.2 of this plan:

.

LLCE drawing and part number, tank farm and tank number defined for the
generation of this characterization database file.

Tank waste characterization data as described in sections 2.2.1and 3.1.2.4
in this plan.
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. Physical data for the LLCE being retrieved. This will include the data as
described in sections 2.2.2 and 3.1.2.5 in this plan.

. LLCE geometry correction factors for the LLCE being retrieved. This will
include the data as described in sections 2.2.3 and 3.1.2.6 in this plan.

. LLCE waste container data for the LLCE being retrieved. This will include
the data as described in sections 2.2.4 and 3.1.2.7 in this plan.

. Radionuclide physical constants and regulatory limits for all radionuclides
present in the tank waste characterization data. This will included the data
as described in sections 2.2.5, 2.2.6, 2.2.8, 3.1.2.7, 3.1.2.8,3.1.2.9, and
3.1.2.11 in this plan. Chemical regulatory limits for all chemicals present in
the tank waste characterization data as described in 3.1.2.7.

The gamma assay data will be input to the LLCE waste characterization analysis
program by reading the gamma assay data file generated by the FRRDS for the
LLCE that was retrieved as described in section 2.3.1 of this plan. This data will
include the gamma spectrum for each of the three HPGe gamma detectors at each
location on the LLCE where the gamma assay spectrum is acquired. The program
will check the dates in the FRRDS data file and compare it to the LLCE retrieval
date entered by the program user. If there is a mismatch the program user will be
notified of the problem. Refer to Appendix C for a description of this file.

Characterization data analysis can be initiated once all user input has been
completed as specified in section 3.1.3.2 of this plan.

The FRRDS produced gamma assay file content shall be analyzed to produce the
estimate for total measured gamma content of the LLCE as specified in section
2.3.2 of this plan.

During analysis of the gamma assay data if gamma assay data is missing for a
section of the LLCE the program will stop and prompt the user to enter the
missing data. Refer to section 2.3.1 and 2.3.2 for a discussion of this problem.

The total measured gamma isotope content for the LLCE will be used to estimate
the total radionuclide and chemical content of the LLCE as specified in section
2.3.2. This will be accomplished by ratioing the measured gamma radionuclide
content to the tank waste content for the tank the LLCE is retrieved from. This
procedure is detailed in section 8.1, Disposal of Tank Farm Long-Length
Contaminated Equipment: Radiological and Chemical Characterization Plan,
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WHC-SD-WM-TCP-007. If the tank waste characterization data has more than
one tank waste layer defined the total radionuclide/chemical content will be
summed by tank waste layer.

Program status will be given to the program user to help the user determine the
current state of the program. Status will be given on a status bar or in a dialog
box.

The program shall generate hard copy reports for the data input, characterization
analysis summary report, and detailed reports for each analysis conducted by the
program. The data input report will print out all data input to the program. The
summary report will print out the data as specified in section 2.3.2. The detailed
reports will print out the tabulated results of the calculations performed in
accordance with sections 8.0 and 8.4 in, Disposal of Tank Farm Long-Length
Contaminated Equipment: Radiologi-al and Chemical Characterization Plan,
WHC-SD-WM-TCP-007.

3.2 EXTERNAL INTERFACE REQUIREMENTS

3.2.1 User Interfaces

3.2.1.1

LLCE Characterization Database Program

The LLCE characterization database program will be a multiple document Interface
(MDI) application. There will be a main program window and child windows that open up
under the main program window. The following sections describe the windows that will be
designed to provide the user interface to the LLCE characterization database program:

3.2.1.1.1

Main Program Window - All windows will operate within the main program
screen area. When the program starts a dialog box will appear prompting the user
to select existing or new file. Selecting new will start the New menu command
(see below). Selecting existing will start the Open menu command (described
below). The menu bar will contain the main menu bar headings of File, Edit,
Data , and Help.

The File menu bar will provide the following commands:
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File Menu Bar

New

This will bring up a file dialog box and will prompt the
program user to enter a path and filename to be used for
storage of user input to the program and for the name of
the file to be used for the LLCE characterization data file.
A new file filename.inp will be created to store user input
to the program. This will also set the name for the LLCE
characterizati- n data file as filename.dbf.

This will bring up a file dialog box and will prompt the
program user to enter the path and filename for an existing
(old) program run. This will read in the filename.inp file
and will restore user input from this file. The LLCE
characterization data file name will be set as filename.dbf.

Save

This save the current user input to the file filename.inp.

Print

This will allow the user to print hard copy reports that
relate to the selected tank farm, tank number, and LLCE
being retrieved. The print option is valid only when one of
the data menu windows is opened (described below).
Information that will be included in all data reports is the
current time, date, program user narme(s), LLCE selected,
tank farm and tank number selected. The user will also
have the option to select printer and setup printer.

Exit

This will exit the program. If any input has changed the
user will be prompted to save data, discard data, or cancel
exit.

The Edit menu bar will provide the following commands:

Edit Menu Bar

Cut This will allow the user to select text using the mouse and
to cut that text to the windows clipboard.
Copy This will allow the user to select text using the mouse and
to copy that text to the windows clipboard.
Paste This will allow text be pasted from the windows clipboard

to the current cursor position.
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The Data menu bar will provide the following commands:

Data Menu Bar

LLCE Select This will open the LLCE select window to select LLCE
part and drawing number, tank farm, and tank number.
Also the program user name(s) is input in this window.
All other selections in the Data menu bar is disabled
until this information is entered.

LLCE Physical | This will open the LLCE physical data window for the
selected LI.CE for review and editing.

Tank Waste This will open the tank waste characterization data
window for the selected tank farm and waste tank for
review and editing.

LLCE Geometry | This will open the LLCE geometry correction factors

window for the selected LLCE for review and editing.

Container This will open the LLCE waste container data window
for the selected LLCE for review and editing.

Radionuclide This will open the radionuclide constants data window

for review and editing.

Rad Reg This will open the radionuclide regulatory limits
windows for review and editing.

Chem Reg This will open the chemical regulatory limits windows
for review and editing.

Setup This will open the setup window for review and editing.
Make DB This will open a dialog box which will allow the

program user to write the LLCE characterization
database file for the selected LLCE or cancel. If write
is selected this will write out the LLCE waste
characterization database file : filename.dbf.

commands:

The Help menu bar will provide the following menu commands menu

Help Menu Bar

Contents

Will display a help screen for the program commands.
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Help Menu Bar

About Will display program version information.

LLCE Select Window - This window is opened when the menu command LLCE
Select is selected. This window is where the part and drawing number for the
LLCE, tank farm and tank number, and program user information is entered. All
menu bar selections under the Dara menu bar, except for LLCE select, is disabled
until this window input is completed. To exit this window the program user can
select next or ok. If the user selects next this automatically opens the LLCE
physical data window. Selecting ok takes the user back to the main window.
Selecting Print from the File menu will allow the user to print the information in
this window.

LI.CE Physical Data Window - This window is opened when the menu command
LLCE Physical is selected. This brings up the LLCE physical data window for the
selected LLCE. The user can review and edit the data as required. To exit this
window the program user can select next or ok. If the user selects next this
automatically opens the tank waste characterization data window. Selecting ok
takes the user back to the main window. Selecting Print from the File menu will
allow the user to print the information for the selected LLCE or optionally
information for all LLCE.

Tank Waste Characterization Data Window - This window is opened when the
menu command Tank Waste is selected. This brings up the current tank waste
characterization data for the selected waste tank. This allow the program user to
review the existing tank waste characterization data and to edit the data according
to section 2.2.1 of this plan. If multiple tank waste layers are defined the distance
from the bottom of the tank to the tip of the LLLCE must be entered here. To exit
this window the program user can select next or ok. If the user selects next this
automatically opens the LLCE geometry correction factors window. Selecting ok
takes the user back to the main window. Selecting Print from the File menu will
allow the user to print the tank waste characterization data for the selected tank.

LLCE Geometry Correction Factors Window - This window is opened when the
menu command LLCE Geometry is selected. This window allows for entry of
the LLCE geometry correction factors described in section 2.2.3 of this plan. To
exit this window the program user can select next or ok. If the user selects next
this automatically opens the LLCE waste container data window. Selecting ok
will open takes the user back to the main window. Selecting Print from the File
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menu will allow the user to print the LLCE geometry correction factors for the
selected LLCE.

LLCE Waste Container Data Window - This window is opened when the menu

command Container is selected. This window allows the program user to review
and change the LLCE waste container size and waste container data (if
necessary)in accordance with section 2.2.4 of this plan. To exit this window the
program user can select next or ok. If the user selects next this automatically
opens the radionuclide constants data window. Selecting ok takes the user back to
the main window. Selecting Print from the File menu will allow the user to print
the LLCE waste container data for the selected LLCE or for all LLCE waste
containers.

Radionuclides Constants Data Window - This window is opened when the menu

command Radionylide is selected. This window allows the program user to
review and edit radionuclide physical constants data in accordance with section
2.2.5 of this plan. To exit this window the program user can select next or ok. If
the user selects next this automatically opens the radionuclide regulatory limits
data window. - Selecting ok takes the user back to the main window. Selecting
Print from the File menu will allow the user to print the radionuclide constant data
currently in the database.

Radionuclide Regulatory Limits Data Window - This window is opened when the
program user selects the menu command Rad Reg. This window allows the
program user to review and edit the regulatory limits for radionuclides in
accordance with section 2.2.6 of this plan. To exit this window the program user
can select next or ok. If the user selects next this automatically opens the
chemical regulatory limits data window. Selecting ok takes the user back to the
main window. Selecting Print from the File menu will allow the user to print the
radionuclide regulatory data currently in the database.

Chemical Regulatory Limits Data Window - This window is opened when the
program user selects the menu command Chem Reg. This window allows the
program user to review and edit the regulatory limits for chemicals in accordance
with section 2.2.7 of this plan. To exit this window the program user can select
next or ok. If the user selects next this automatically opens the setup data
window. Selecting ok takes the user back to the main window. Selecting Print
from the File menu will allow the user to print the radionuclide regulatory data
currently in the database.
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3.2.1.1.7 Setup Data Window - This window is opened when the program user selects the
menu command Setup. This window allows the program user to edit the list of
valid gamma radionuclides. The valid gamma radionuclice list is discussed in
section 2.3.1 of this plan. To exit this window the program user can select next or
ok. If the user selects next this automatically opens the Write Database dialog box
(Make DB menu command). If all required user input is complete the LLCE
characterization database file filenare.dbf can be written. Selecting ok takes the
user back to the main window. Selecting Print from the Eile menu will allow the
user to print the setup data currently in the database. To exit this window the
program user selects ok.

3.2.1.2 LLCE Waste Characterization Analysis Program

The LLCE waste characterization analysis program will also be a MDI application.
* There will be a main program window and child windows that open up under the main
program window. The following sections describe the windows that will be designed to
provide the user interface to the program:

3.2.1.2.1 Main Program Window - All windows will operate within the main program
screen area. The menu bar will contain the menu bar headings of File, Edit, Data,
and Heip. When the program starts a dialog box will be displayed prompting the
user to select existing analysis or new analysis. Selecting new will start the New
menu command (see below). Selecting existing will start the Open menu
command (see below).

The File menu bar will provide the following commands:
File Menu Bar

New This will bring up a file dialog box and will prompt the
program user to enter a path and filename to be used for
storage of user input. New file filename.an! will be created
to store user input to the program.

Open This will bring up a file dialog box and will prompt the
program user to enter the path and filename for an existing
(old) program run. This will read in the filename.anl file
and will restore user input from this file,

Save This save the current user input to the file filename.an!.
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File Menu Bar

Print This will allow the user to print hard copy report of user
input and program analysis output. The print option will
bring up a print window that will allow the user to select
which reports to print.

Exit This will exit the program. If any input has changed the
user will be prompted to save data, discard data, or cancel
exit.

The Edir menu bar will provide the following commands:

Edit Menu Bar

Cut This will allow the user to select text using the mouse and
to cut that text to the windows clipboard.

Copy This will allow the user to select text using the mouse and
to copy that text to the windows clipboard.

Paste This will allow text be pasted from the windows clipboard
to the current cursor position.

The Data menu bar will provide the following commands:

Data Menu Bar

LLCE Select This will open the LLCE select window to select LLCE
part and drawing number, tank farm, tank number, and
tank riser number. In addition the program user name(s)
can be entered. After the LLCE is selected the file path
and name for the LLCE characterization data file and
FRRDS gamma assay data file is entered and verified in
this window.

Field Data This will open the field data window for the entry of
field data.
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Data Menu Bar

Add Data This will open the add missing data window for adding
missing gamma assay data. This menu selection will be
disabled normally. It will become active if during an
analysis run (Calculate menu command) gamma assay
data is found to be missing in the FRRDS gamma assay
data file.

Calculate This will open the LLCE calculate dialog box. This
dialog boxes starts characterization analysis and provides
status of analysis run. '

The Help menu bar will provide the following menu commands menu

commands:
Help Menu Bar
Contents Will display a help screen for the program commands.
About Will display program version information.

3.2.1.2.2 LLCE select window - This window is opened when the program user selects the
LLCE Select menu command. The user shall input the LLCE drawing and part
number, tank farm, tank number, LLCE retrieval date, and tank riser that the
LLCE is being retrieved from. In addition the program will ask for the program
user(s) name and for the package PIN number (if available).

After the LLCE drawing number, tank farm, and tank number has been
entered, areas in this window will become active which will require the
program user to enter the full path and filename for the LLCE characterization
database file that was generated for this LLCE retrieval. In addition the user is
required to enter the full path and filename for the FRRDS generated gamma
assay data file. Standard Windows file dialog boxes will assist the user in
locating and selecting these files. The program will verify that the LLCE
drawing number, tank farm, and tank number matches the information
recorded in the LLCE characterization database file. In addition the program
will verify that the entered LLCE retrieval date matches the dates in the
FRRDS generated gamma assay data file. If there is a mismatch the program
user will have the option of quitting the program, selecting another LLCE
characterization database file, selecting another FRRDS data file, or selecting
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another LLCE. To exit this window the user can select next or ok. Selecting
next opens the field data input window. Selecting ok takes you back to the
main window.

Field data window - This window is opened when the program user selects the
menu command Field Data. The user is required to enter the arbitrary crane
position in thousands of a feet when the LLCE mounting flange is visible in the
video view window on the LLCE flexible receiver assembly. There is also an
entry on this screen for the LLCE retrieved weight, weight of the flexible receiver
bag, and the weight of the lifting dunnage that will remain inside the flexible
receiver bag. The user can enter either the weight for each component or a gross
weight for all three. To exit this window the user selects calculate or ok.
Selecting calculate will initiate the Calculate menu command which will start the
characterization analysis for the LLCE. Selecting ok wil! take the program user
back to the main program window.

Add Data window - This window is opened when the program user selects the Add
Dara menu command. Normally this command is inactive. It becomes active only
if during characterization analysis (Calculate menu command) gaps are found in
the FRRDS gamma assay data. If gaps are found in the gamma assay data the
characterization analysis will stop and this data window will open. The program
user will be prompted to add the missing gamma radionulide content data for the
one foot section(s) that are missing data. To exit this window the user selects
calculate or ok. Selecting calculate will initiate the Calculate menu command
which will start the characterization analysis for the LLCE. Selecting ok will take
the program user back to the main program window.
Calculate Dialog Box - This dialog box is opened when the program user selects
the Calculate menu command. Current status of analysis run will be displayed in
this box. This box will close when characterization analysis is complete and a
dialog box will be displayed which will notify the user that characterization
analysis is complete and that analysis was either successful or failed. If the
analysis failed the program user will have the option to display the error report for
the analysis run. Errors and warnings will be saved in the filename.err file.

Print select Window - This window is opened when the program user selects the
Print menu command under the File menu bar. This menu command is inactive
until the LLCE select window and field data window input has been completed.
Only the LLCE summary report can be printed until characterization analysis has
been successfully completed. Each report will have the selected LLCE part and
drawing number, tank farm, tank number, tank riser, program user name(s), and
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current time and date print on each report. Also the program user has the option
to select printer and to setup printer.

The program will combine the following reports where possible to minimize
the amount of hard copy.

The following reports can selected to be printed:

. The LLCE Select Report will print information entered in the LLCE
select and field data windc we

»  The LLCE Characterization »,nalysis Summary Report will print the
summary results of the characterization analysis run as specified in
section 2.3.3.

. The FRRDS Gamma Assay Summary Report will print out for each one

foot section of the selected LLCE : the measured gamma assay content,
the geometry correction factors applied, and the geometry corrected
gamma assay content. The total measured gamma radionuclide inventory
will be summed and printed at the end of the report. If the tank waste
layer has more than one layer then subtotals for each layer will be
printed.

. The Calculated Radionuclide/Chemical tent report will print out the
table showing the calculated total radionuclide and chemical content for
the selected LLCE. The percent of waste for each component will be
reported in this table. If the tank waste layer has more than one layer
then subtotals for each layer will be printed.

The hard copy report will list any fission/activation nuclides that exceed
one percent of the weight of the waste. If there are less than three
radionuclides that exceed one percent, then the radionuclides with the
highest concentration will be reported. At least three radionuclides will
be reported.

The hard copy report will list any TRU/Fissile nuclides that exceed one
percent of the weight of the waste. If there are less than three
radionuclides that exceed one percent, then the radionuclides with the
highest concentration will be reported. At least three radionuclides will
be reported.
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The LLW lations Summary report will print out the table that shows
the sum of fractions for Category 1 and Category 3 LLW, and NRC
Class C. The report will print recommended LLW characterization from
these results. Categories can be Category 1 LLMW, Category 3 LLMW,
greater than Category 3 LLMW, greater than Class C.

Note it is possible that some LLCE may be characterized as Low Level
Waste (LLW). The program will always assume the LLCE is mixed
waste in it’s printed reports.

The TRU Calculations Summary report will print out the table that shows

the sum of fractions for TRU isotopes. The report will print at bottom of
report if LLCE waste package is TRU or suspect TRU baséd on this sum.
Categories can be TRU or suspect TRU.

The CWC LLW Storage Noncombustible Limits report will print out the

table that shows the sum of fractions for the Category 3 noncombustible
waste limits. This is valid if LLCE waste package is stored at the Central
Waste Complex (CWC). It is assumed that LLCE waste packages going
into storage will be considered noncombustible.

The PE-Ci Report for TRU Waste report will print out the table used to
calculate the Plutorium Equivalent Curie (PE-Ci) for the LLCE waste
package. This is only valid for TRU waste. The report will flag if the
35 PE-Ci limit for TRU waste packages is exceeded.

The Fissile Gram Equivalent For TRU Waste report will print out the
table used to calculate the Fissile Gram Equivalent (FGE) content for the
LLCE waste package. This is only valid for TRU waste.

The Alpha Content For TRU Waste report will print out the table used to
calculate the alpha content of the LLCE waste package. This is only
valid for TRU wasle.

The Accountable Materials report will print out the table used to
determine if the LLCE waste package contains accountable materials. If
accountable materials are present the program user will be reminded that
a2 DOE/NRC Form 741 is required.

The Heat Generation report will print out the table used to determine the
heat generation in the LLCE waste package. The report will report if the
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LLCE waste package exceeds a 3.5 W/m® (0.1 W/ftY heat generation
rate.

The Transportation Category report will print out the table use to

determine the transportation category for the LLCE waste package.
Transportation categories can be LSA, Limited Quantity, Type A, Type
B, and HRC.

The CWC Type A Category report will print out the table used to
determine if the LLCE waste package would be categorized as a Type A

waste package using the CWC package limits and A2 values found in
WHC-EP-0063-4, Appendix L.

The CWC Dose Equivalent Curie (DE-Ci) report will print out the table
used to calculate the CWC DE-Ci content of the LLCE waste package.

This is only valid if the CWC Type A Category report limits are
exceeded.

The LLCE U-235 Content report will report the U content of the
LLCE waste package. If this exceeds 15 grams the program user will be
reminded that a criticality safety analysis is required.

The SARP LIMITS report will print the table used to determine if any
LLCE waste packaging SARP limits have been exceeded. If limits are
exceeded the report will indicate which limits have been exceeded and by
how much.

The Hazardous Waste Designation report will print the recommended
hazardous waste codes for the LLCE waste package. Designation logic
will be printed.

The Error Report - will print errors and warning generated during
characterization analysis.

3.3 OTHER REQUIREMENTS

3.3.1 Operations

The LLCE characterization database program is not intended for field use. The LLCE
waste characterization analysis program can be used in the field or in the office after LLCE
retrieval. Some of the information required by the LLCE waste characterization analysis
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program must be recorded in the field at the time of LLCE retrieval. The crane position
reading at the point where the LLCE mounting flange is visible in the flexible receiver video
view window must be recorded. Also if the retrieved LLCE, flexible receiver bag, and lifting
dunnage weights are measured in the field, this information is required by the LLCE waste
characterization analysis program. If the LLCE waste characterization analysis program is
used during LLCE retrieval this information can be entered directly into the program at the
time the field information is recorded.

3.3.2 Reliability and Recovery

Error detection, error handling, and recovery was discussed in section 3.1.1.4 of this
plan. Data files generated by these programs should be backed up by the program user to
prevent data loss.
- 3.3.3 Audit

All printed reports will indicate data file name and date so computer data files can be
matched with hard copy reports. All input data can be printed in hard copy reports to allow
for checking of input data. In addition an audit file will be maintained which will track use of
the characterization database program.

3.3.4 Testing and Acceptance Criteria

A document will be written to perform the acceptance test according to the requirements
of WHC-CM-3-10 for the software developed under this plan.

3.3.5 Documentation

A user’s manual shall be written in FY97 for the programs developed under this plan.
3.3.6 Training

The user’s manual for this program will give a tutorial on use of the programs.
Completion of the tutorial in the manual should provide adequate training for user of the
software.

4.0 SCHEDULE
The schedule for this software development effort is shown in Appendix D. Software

development is to be complete by 9/30/96.

33



WHC-SD-WM-CSWD-080 Rev.0
5.0 REFERENCES
Roach, H. L., 1995, Disposal of Tank Farm Long-Length Contaminated Equipment:
Radiological and Chemical Characterization Plan, Rev. 0, Westinghouse Hanford

Company, Richland Washington.

WAC 173-303, 1993, "Dangerous Waste Regulations," Washington Administrative Code, as
amended.

Resource Conservation and Recovery Act of 1976, 42 U.S.C. 6901, et seq.

Titzler, P. A., 1993, Disposal of Tank Farm Long-Length Contaminated Equipment:
Alternative Options Study and Engineering Support Information, WHC-SD-WM-ES-265,
Rev. 0-A, Westinghouse Hanford Company, Richland, Washington.

Willis, N. P., Hanford Solid Waste Acceptance Criteria, WHC-EP-0063-4, Westinghouse
Hanford Company, Richland, Washington.

WHC Traffic Group, Hazardous Materials Packaging & Shipping, WHC-CM-2-14,
Westinghouse Hanford Company, Richland, Washington.

Software Practices, WHC-CM-3-10, Westinghouse Hanford Company, Richland, Washington.

Twins User Guide, Tank Waste Information Network system Version 4.0, PNL—8824-2, Pacific
Northwest Laboratory, Richland, Washington.

Serier, M. N., Material Control and Accountability Plan, WHC-IP-1019, Rev. 0,
Westinghouse Hanford Company, Richland, Washington.

Troyer, G. L., Project Wi51 Flexible Recciver Radiation Detector System
acceptance Test Report, WHC-SD-W151-ATR-001, Rev. 0, Westinghouse Hanford
Company, Richland, Washington.

Killian, Wayne E., 1992, Operator’s Guide for VAXGAP, a Gamma-Ray Spectrum Analysis
Package, EGG-2672, Idaho National Engineering Laboratory, Idaho Falls, Idaho.

Killian, Wayne E., 1992, Operator’s Guide for the Hanford Spectrometer System, RML-
B7A0-92-002, Idaho National Engineering Laboratory, Idaho Falls, Idaho.

Tedeschi, David J., 1994, Specification for Gamma Assay, WHC-V-W320-0001, Rev. 0
Westinghouse Hanford Company, Richland, Washington.

>

34



WHC-SD-WM-CSWD-080 Rev.0
Dowell, Jack L., 1993, Project W-151 Flexible Receiver Radiation Detector System

Acceptance Test Report, WHC-SD-W151-ATR-001, Rev 0, Westinghouse Hanford
Company, Richland, Washington.

35



WHC-SD-WM-CSWD-080 Rev.0

APPENDIX A - DATABASE FILE DESCRIPTION AND STRUCTURE
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1.0 DATABASE FORMAT

This appendix describes the format of the databases maintained by the LLCE
characterizaticn database program. All databases will be in Microsoft Access 2.0 format but
will be directly accessed, viewed, and edited by the LLCE characterization database program.

Terminology

Type - Type of data entered into Field
A - Alphanumeric any letter or number allowed up to field length
S - Short Integer number (-32,767 to 32,767)
N - Number entry with 15 significant digits (10°% to 10+3%)
D - Date entry (mm/dd/yy)
M - Memo field

Size - Size of field. N/A means the size is preset by data type

Index Key -  Index (Sort order) for database. Determine which fields and order for sorting
of database

1.1 Tank Waste Characterization Data

The database file name is TANKCHAR.DB. Fields defined in this database are as
follows:

TANKCHAR.DB

# Field Name Type Size Index Key
1 Tank Farm A 2 1

27 Tank Number S N/A 2"

3 Constituent A 25 3

4 CAS A 14 4

7 Unit Mass A 2

8 Unit Volume A 2

9 Layer Content N N/A

10 Layer Number S N/A
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TANKCHAR.DB

| # I Field Name | Type Size Index Key
0 | Layer Number S N/A
11 Layer Thickness N N/A
12 SpG Layer N N/A
37 Time A 12
38 Date D N/A

Field Notes:

a)  Tank Farm and Tank Number is the location where this data applies.

a) Constiment for radionuclides is the one or two letter abbreviation for the element name.
CAS for radionuclides is the isotope number. For Chemicals constituent is the proper
chemical name and CAS is the Chemical Abstract Name for the chemical.

b)  Unit Mass is kg or Curies. All user entries in other units are converted to these units

c)  Unit Volume is in m®. If blank content of constituent is defined in terms of total content
for waste layer. All user volumes entries in other units are converted to m®.

d)  Layer Content is the layer content for the specified constituent in the unit mass and
volume for layer.

e)  Layer Number is the tank waste layer number (1-10) for this constituent.

f) Layer Thickness is the Layer thickness in meters for layer.

g)  SpG Layer is the specific gravity for waste layer.

h)  Edit time and date is the last time and date this record was updated.
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1.2 LLCE Physical Data and Description

This database filename is LLCEPHYS.DB. Fields defined in this database are as

follows:

‘ LLCEPHYS.DB

# Field Name Type Size Index Key
1 LLCE Description A 50

2 Max Diameter N N/A

3 Max Tip to Tip Length N N/A

4 Flange to Tip Length N N/A

5 LLCE Weight N N/A

6 Drawing list A 45 3
7 Drawing Number N N/A 1
8 Part Number A 6 2
9 Farms A 30

10 Waste Container Size S N/A

i1 Comment A 240

12 Time A 12

13 Date D N/A

Field Notes:

a)  LLCE Description is the descriptive name of the LLCE.

b)  Max Diameter is the maximum circular diameter of the LLCE with the center of this
circle located at the midpoint between the lift points. All entries are converted to
meters. If this entry is zero the maximum diameter has not been defined or requires
field verification.

¢} Max tip to tip Jength is the distance from the uppermost tip to the bottom tip of the

LLCE (Max Length). All entries are converted to meters. If this entry is zero this
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length can not be defined using assembly drawing. Other sources of information must
be found to determine this length.

Flange to tip length is the distance from the bottom surface of the LLCE mounting
flange to bottom tip of the LLCE. All entries are converted to meters. If this entry is
zero this length must be determined in the field or from sources other than the assembly
drawing. Many of these LLCE are adjustable so this length is determined at installation.

LLCE weight is the current dry clean weight of the LLCE. All entries are converted to
kg.

Drawing List is complete drawing number(s) for the LLCE. There may be more than
one drawing number listed here. The primary assembly drawing should be the first
number entered. This number typically starts with a “H-2" prefix. This will not be true
for vendor only drawings.

Drawing number is the number part for the primary assembly drawing for this LLCE.
For a typical H-2-XXXXXX Hanford drawing this is the “XXXXXX” number part of
the drawing number. For vendor only drawings this will be recorded as zero to let the
program know that the key will be on the drawing list field.

Part number is the part number on drawing number for this LLCE. Some drawings
have more than one LLCE defined. If this entry is zero there are part numbers specified
for the LLCE in the assembly drawing(s). Note that several LLCE with different .
lengths and diameters may share the same part and drawing number.

Farms are the tank farms this LLCE was designed for. Typically this is from the title
block on the LLCE assembly drawing. Specific tanks may also be specified.

Waste Container Size is the LLCE waste container size this LLCE fits in. This will be a
number between 1 and 8.

Comment allows a short comment to be entered for the LLCE.

Time and Date is the time and date the data for this LLCE was last changed.

1.3 LLCE Geometry Correction Factors

This database filename is LLCEGEOM.DB. Fields defined in this database are as

follows:
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LLCEGEOM.DB

# Field Name Type Size Index Key
1 Drawing List A 45
2 Drawing Number N N/A 1
3 Part Number A 6
4 Start Location N N/A 2
5 Gamma Isotope Element A 4 3
6 Gamma Isotope Number S N/A 4
7 Correction Factor #1 N N/A
8 Correction Factor #2 N~ N/A
9 Correction Factor #3 N N/A
10 Time A 12
11 Date D N/A
Field Notes:
a)  Drawing List, Drawing Number, and Part Number are as explained in section 1.2' in this
appendix.

b)  Start Location is the distance (m) from the bottom tip of the LLCE to the point on the
LLCE where the geometry correction factor is first applied. This geometry factor is
applicable to the section of the LLCE between the current start location and the start
location of the next data record. If there is no next data record the correction factor
applies from the current start location to the bottom flange of the LLCE.

c¢)  Gamma Isotope Element is the two letter abbreviation for the element name for which
the geometry correction factor is defined. If this is a metastable element enter the letter
‘m’ before the element name. For example the element *"™Cs would be entered as

“mCs”.
d)  Gamma Isotope Number is the isotope number for the gamma isotope element.
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e)  Correction Factor #1 is the geometry correction factor for detector #1 that is used to
correct the FRRDS measured gamma isotope content numbers for geometry of the
LLCE. Correction Factor #2 and #3 are the correction factors for detector #2 and
detector #3.

f)  Time and date is the time and date this record was last changed.

1.4 LLCE Waste Container Data

The name of this database is LLCECONT.DB. Fields defined in this database are as

follows:

LLCECONT.DB

,#— Field Name Type Size Index Key
1 Container Number S N/A 1
2 Container OD N N/A
3 Container ID N N/A
4 Container Length N N/A
5 Max LLCE Diameter N N/A
6 Max LLCE Length N N/A
7 Tare Weight N N/A
8 Container Internal Volume N N/A
9 Container External Volume N N/A
10 Container Drawing Number A 30
11 Skid Drawing Number A 30
12 Skid Weight N N/A
13 Time A 12
14 Date D N/A
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Field Notes:

a)  Container number is a number 1 through 8 representing the 8 LLCE waste containers.

b)  Container OD is the outside diameter of the container in meters.

¢)  Container ID is the inside diameter of the container in meters.
d)  Max LLCE diameter is the maximum diameter, in meters, for any LLCE that will fit in
this container.

e)  Max LICE length is the maximum tip to tip length, in meters, for any LLCE that will
fit in this container.

3] Tare weight is the empty weight of the container in kg.

g)  Container internal volume is the internal volume of the container in m®.

h) Container external volume is the external volume of the container in m®. This volume is
equal to the container length times height.

D Container drawing number is the “H-2" drawing number for the top assembly for this
container.
D Skid drawing number is the “H-2" drawing number for the top assembly of the sk.id that

fits inside this container.

k)  Skid weight is the weight of the skid in kg.

1) Time and date it the time and date the data for this container was last changed.

1.5 Radionuclide Physical Constants

The name of this database is LLCENUC.DB. Fields defined in this database are as

follows:

LLCENUC.DB

# Field Name Type Size Index Key ]
1 Element Isotope S N/A 2
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LLCENUC.DB

# Field Name Type Size Index Key
2 Element Name A 8 1
3 Specific Activity N N/A
4 Half Life N N/A
5 Heat Generation Rate N N/A
6 Daughter 1 S 7
7 Branching Ratio N N/A
8 Daughter 2 S 7
9 Branching Ratio N N/A
10 Alpha Emitter S N/A
11 Beta Emitter S N/A
12 Gamma Emitter S N/A
13 Fissile Material S N/A
14 Hanford TRU Isotope S N/A
15 NRC TRU Isotope S N/A
16 Time A 12
17 Date D N/A
Field Notes:
a)  Element Isotope is the isotope number for this radionuclide
b) Element Name is the two letter abbreviation for the element name for the radionuclide.

If this is a metastable element enter the letter ‘m’ before the element name. For example
the element *"™Cs would be entered as “mCs”.

¢)  Specific Activity is the number of curies in one gram of the radionuclide (Ci/g).
d)  Half Life is the time for cne half of the radionuclide to decay in years.
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¢)  Heat Geperation Rate is the heat generated by radioactive decay of the radionuclide in
watts per cubic meter (w/m®). .

f)  Daughter 1 is the name of the daughter radionuclide (i.e. ¥™Ba or 137m-Ba). Daughter
1 Ratio is the branching ratio from the parent radionuclide. Daughter 2 is the name of a
second daughter product from the decay of the parent radionuclide. Daughter 2 Ratio is
the branching ratio for this second radionuclide.

Alpha Emitter will indicate if this radionuctide emits an alpha particle when it decays (1
for true and O for false).

aq
~

h)  Beta Emitter will indicate if this radionuclide emits a beta particle when it decays (1 for
true and O for false).

D Gamma Emitter will indicate if this radionuclide emits gamma radiation when it decays
(1 for true and O for false).

j)  Fissile Material will indicate if this radionuclide is a fissile material as specified in
WHC-EP-0063-4, latest revision (1 for true and O for false).

k)  Hanford TRU Isotope will indicate if this radionuclide is a transuranic (TRU)
radionuclide as specified in WHC-EP-0063-4, latest revision (1 for true and O for false).

)} NRC TRU Isotope will indicate if this radionuclide is a transuranic (TRU) radionuclide
by NRC definition as specified in WHC-EP-0063-4, latest revision (1 for true and 0 for
false). NRC specifies all alpha emitting nuclides with half lives greater than 5 years.

m) Time and Date is the time and date this record was last changed.

1.6 Radionuclide Regulatory Data

The name of this database is RADREG.DB. Fields defined in this database are as
follows:

RADREG.DB ) I
# Field Name Type Size Index Key

1 Element Isotope S N/A 2

2 Element Name A 8 1
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RADREG.DB

I—_#_ Field Name ‘ Type Size Index Key
3 Category 1 LLW Limit N N/A
4 Category 3 LLW Limit N N/A
5 NRC Class C Limit N N/A
6 Noncombustible Waste Limit N N/A
7 PE-Ci Correction Factor N N/A
8 Pu-239 FGE Correction Factor N N/A
9 DOT A2 Limit N N/A
10 EP-0063 A2 Limit N N/A
11 CWC Curie Limit per Package N N/A
12 DE-Ci Curie Factor N N/A
13 Current SARP Limits N N/A
14 741 Reporting Unit N N/A
15 Time A 12
16 Date D N/A

Field Notes:

a)  Element Isotope is the isotope number for this radionuclide

b)  Element Name is the two letter abbreviation for the element name for the radionuclide.
If this is a metastable element enter the letter ‘m’ before the element name. For example

the element *™™Cs would be entered as “mCs”.

c)  Category 1 LLW Limit is the limit for a waste package for the radionuclide in curies for
Category 1 Low Level Waste Disposal. The limits will be as specified in WHC-EP-
0063-4, latest revision.
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Category 3 LLW Limit is the limit for. a waste package for the radionuclide in curies for
Category 3 Low Level Waste Disposal. The limits will be as specified in WHC-EP-
0063-4, latest revision.

NRC Class C Limit is the limit for a waste package for the radionuclide in curies for

Category 3 Low Level Waste Disposal. The limits will be as specified in WHC-EP-

0063-4, latest revision. Units are in Ci/m® except for 2*'Pu and >2Cm where the units
are in nCi/g.

Cat 3 Nocomb.Limit is the limit for a waste package for the radionuclide in curies for
Category 3 Low Level Waste Disposal of a noncombustable waste package. The limits
will be as specified in WHC-EP-0063-4, latest revision.

PE-Ci Correction Factor is the multiplication factor applied to selected radionuclides to
calculate the equivalent 2*Pu content of a waste package. The limits will be as specified
in WHC-EP-0063-4, latest revision.

Pu-239 FGE Factor is the multiplication factor applied to selected radionuclides to
calculate the equivalent 2*Pu fissile gram equivalent content of a waste package. The
limits will be as specified in WHC-EP-0063-4, latest revision.

DOT A2 Limit is the limit for a waste package for the radionuclide in curies for a Type-
A waste package. The limits will be as specified in the current DOT 49 CFR 173.

EP-0063 A2 Limit is the limit for a waste package for the radionuclide in curies for a
Type-A waste package. The limits will be as specified in the current WHC-0063-4,
Appendix L.

CWC Limit per Package is the limit for a waste package for selected radionuclides in
curies for a Type-A waste package. The limits will be as specified in WHC-EP-00634,
latest revision.

DE-Ci Curie Factor is the multiplication factor applied to selected radionuclides to
calculate the Dose Equivalency Curies (DE-Ci) in a waste package. The limits will be
as specified in WHC-EP-0063-4, latest revision.

Current SARP Limits is the curie limit for the radionuclide as established in the SARP
for the waste package.

741 Reporting Unit limits for radionuclides in grams. The limits will be as specified in
WHC-IP-1019, Material Control and Accountability Plan.
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0) Time and Date is the time and date this record was last changed.
1.7 Chemical Regulatory Data

The name of this database is CHEMREG.DB. Fields defined in this database are as
follows:

CHEMREG.DB
PSS e e e ————

# Field Name Type Size Index Key
1 Constituent Name A 30 2
2 CAS # A 12 1
3 D Code A 4
4 D Code Limit N N/A
5 Time A - 12
6 Date D N/A
Field Notes:

a) Constituent Name is the name of the chemical
b) CAS # is the chemical abstract number for the chemical.
¢) D Code is the ‘D’ code number that applies to chemicals that are heavy metals.

d) D Code Limit is the limit a ‘D’ listed chemical in mg/L. This will taken from WAC
173-303-090(8)(C).

e) Time and Date is the time and date this record was last changed.
1.8 LLCE Setup

The name of this database is LLCESET.DB. This database saves the list of valid
measured gamma radionuclides. The structure of this database is as follows:
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LLCESET.DB

I Field Name Type Size [ Index Key |
1 Element Isotope S N/A 1
2 Element Name A 8 2
3 Time A 12
4 Date D N/A

Field Notes:

a)  Element Isotope is the isotope number for this valid gamma radionuclide

b)  Element Name is the two letter abbreviation for the element name for the valid gamma
radionuclide. If this is a metastable element enter the letter ‘m’ before the element
name. For example the element *’™Cs would be entered as “mCs”.

c¢)  Time and Date is the time and date this record was last changed.

1.8 Audit File Format

The name of this database is LLCEAUD.DB. This database saves information for the
use of the LLCE Characterization database program. The structure of this database is as

follows:

LLCEAUD.DB

# Tield Name Type TW
1 User Name A 30

2 Char Data File Name A 42

3 LLCE Description A 50

4 LLCE Drawing Number N N/A

5 LLCE Part Number A 6

6 Waste Tank A 8
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LLCEAUD.DB

l—#—_ Field Name Type Size I Index Key
7 Tank Riser A 6
8 TANKCHAR.DB Date D N/A
9 LLCEPHYS.DB Date D N/A
10 LLCEGEOM.DB Date D N/A
11 LLCECONT.DB Date D N/A
12 LLCENUC.DB Date D N/A
13 RADREG.DB Date D N/A
14 CHEMREG.DB Date D N/A
15 LLCESET.DB Date D N/A
16 Time A 12 2
17 Date D N/A 1
Field Notes:
Field Notes:

a)  User Name is the user name entered by the program user.

b)  Char Data File Name is the name selected by the program user to save user input and
the LLCE characterization database file used by the LLCE characterization analysis

program.

c¢)  LLCE Description is the description of the selected LLCE as entered into the

LLCEPHYS.DB database.

d)  LLCE Drawing Number is the drawing number of the selected LLCE as entered into the
LLCEPHYS.DB database.

e)  LICE Part Number is the part number of the selected LLCE as entered into the

LLCEPHYS.DB database.
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f)  Waste Tank and Tank Riser are the waste tank and tank riser selected by the program
user for LLCE retrieval.

gy TA R L e B Date
D LCEN at D te EMREG.

MQMES_ELDB_D&LQ are the dates these databases were last changed.
1.9 Database File Generated for LLCE Retrieval

This file will not be in Microsoft Access 2.0 format. It will be a binary file generated
by the LLCE characterization database program containing the data that pertains to the LLCE
being retrieved. This is the database file required by the LLCE waste characterization analysis
program. This file will consist of data from all eight databases maintained by the
characterization database program.

LLCE data will be extracted from the LLCEPHYS.DB database for the LLCE that is being
retrieved. Geometry correction factors for the LLCE will be retrieved from
LLCEGEOM.DB. Tank waste characterization data, for the waste tank the LLCE is being
retrieved from, will be extracted fromZ"ANKCHAR.DB. The waste container physical data
will be extracted from the LLCECONT.DB. Physical constants for the radionuclides present
in the tank waste characterization information will be extracted from LLCENUC.DB.
Regulatory data for the radionuclides and chemicals listed in the tank waste characterization
data will be extracted from RADREG.DB and CHEMREG.DB. LLCE suspect TRU limit, the
list of gamma radionuclides to be measured by the FRRDS system will be read from
LLCESET.DB.

All of the extracted data will be saved to the file name selected by the program user
when the LLCE characterization database program was started. This file can be copied and
transferred to the computer running the LLCE waste characterization analysis program via a
floppy disk.
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APPENDIX B - DESCRIPTION OF EXISTING FRRDS SOFTWARE
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1.0 SYSTEM DESCRIPTION

The Flexible Receiver Radiation Detector System (FRRDS) was designed as part of
project W-151, Tank 101-AZ Waste Retrieval System. It’s purpose is to provide a remote and
automated method of identifying gamma-ray emitting radioisotopes in the waste remaining on
an LLCE.

The FRRDS uses 3 High Purity Germanium (HPGe) detectors, nuclear instrumentation,
a microVAX VAXstation 4000 control computer, a modified amplifier/data multiplexer and
control/analysis software. A modified version of the VAXGAP software code is used to
preform the control/analysis function.

A description of the existing FRRDS software is as follows:
AXGAP PROGRAM (Runs on VAX

. Command GS starts VAXGAP.

. Command BS;60 starts a repetitive 60 second cycle of data acquisition, analysis of
spectra from all three detectors, and saving of resulting data. An additional function of
BS command is to create an ASCII file that contains the names of the saved spectrum
files. This file is used by the AVR2 program.

. Command ENDBS stops program.
AVR2 PROGRAM (Runs on VAX

. AVR2 is a separate program that must be run after data acquisition is complete for an
LLCE (the LLCE has been removed and gamma assay is complete). It takes the saved
spectrum files (3 records for each one foot segment) and computes the concentration
values for all nuclides identified. It uses the ASCII file created by VAXGAP with the
names of the spectrum files to determine which files to use. The result files (one per
foot length) are saved with a .RES file type. There is an ASCII file created that contains
summary information for each of the three detectors. This ASCII summary information
file is the file that will be used by the LLCE waste characterization analysis program.

Note AVR2 is derived from the original program AVR which averaged the output from

all three detectors. Now with different shielding on all three thermocouples averaging is
not possible.
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SPREAD PROGRAM (Runs on IBM-PC

SPREAD is an WHC produced software code that reads in the ASCII encoded summary
results file created by AVR2. This file must be transferred from the VAX to an IBM-
PC. It reads the summary results file, discards invalid reported gamma radionuclides,
and produces a file for each of the three detectors in comma delimited format. These
comma delimited files can be read into a spreadsheet program to create a spreadsheet of
the results. The LLCE waste characterization analysis program will not use this
program.

2.0 TRANSFER OF FRRDS RESULTS TG IBM-PC

The VAXstation comes with a MSDOS emulation package that allows MSDOS programs

to run on the VAX. To run an MSDOS program you type in SOFTPC at the $ VAX
command prompt. All of the files stored in the users current directory will appear under
drive letter E:. To properly transfer the ASCII coded results files to a floppy disk you must
- use the command VMS_T0_DOS. The program user must refer to the VAX documentation
for more information.

3.0 FRRDS References

Kiltian, Wayne E., 1992, Operator’s Guide for VAXGAP, a Gamma-Ray Spectrum Analysis

Package, EGG-2672, Idaho National Engineering Laboratory, Idaho Falls, Idaho.

Killian, Wayne E., 1992, Operator’s Guide for the Hanford Spectrometer System, RML-

B7A0-92-002, Idaho National Engineering Laboratory, Idaho Falls, Idaho.

Tedeschi, David I., 1994, Specification for Gamma Assay, WHC-V-W320-0001, Rev. 0,

Westinghouse Hanford Company, Richland, Washington.

Dowell, Jack L., 1993, Project W-151 Flexible Receiver Radiation Detector System

Acceptance Test Report, WHC-SD-W151-ATR-001, Rev 0, Westinghouse Hanford
Company, Richland, Washington.
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APPENDIX C - FRRDS ASCII ENCODED RESULTS FILE FORMAT
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1.0 DESCRIPTION
The Flexible Receiver Radiation Detector System (FRRDS) ASCII encoded results file is
produced by the VAX program AVR2. It contains the results from each of the three gamma

assay detectors for the LLCE that was retrieved.

There are 10 column of data in this file. The first three lines in the file are the headers
for these ten columns as follows:

Count | Start Count Crane
Spectrum | Dzte Time Time Date | Time | Position Nuclide | Activity Error

Spectrum - This is the name of the spactrum record for one gamma assay detector. This is a 11 character name
assigned by the VAXGAP program. The first 2 characters designate the detector.
AIXXXXXXXXX - designates Detector Al
A2XXXXXXXXX - designates Detector A2
AZXXXXXXXXX - designates Detector A3
Count Date - is the date this record was acquired (date LLCE being retrieved).
Start Time - is the time current spectrum count was started.
Count Time - is the number of seconds for counting for this record.
Date - is the date this record was acquired (date LLCE being retrieved).

Time - is the end time for the spectrum count,

Crane Position - is the arbitrary reading of crane position when this record was acquired in thousands of a foot
(107).

Nuclide - is the nuclide measured by the detector. There is a two digit number combined with the abbreviation
for the element name followed by up to two spaces and the isotope number.

Activity - This is the activity measured for the nuclide in micro curies.
Error - is the VAXGAP report of error in the gamma inventory measurement.

The next line in the file starts the individual spectrum records for the three gamma assay
detectors. The first line contains the spectrum, count date, start time, count time, date, time,
and crane position. The next line contains the nuclide, activity, and error estimates. There
will be one line for each nuclide. When the next line read in contains “A1" , “A2", or “A3"
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as the first two characters in the line, this identifies the beginning of another detector spectrum
record. )
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APPENDIX D - SCHEDULE
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SCHEDULE DESCRIPTION
SOFTWARE FUNCTIONAL CRITERIA AND MANAGEMENT PLAN
Write Software Functional Criteria and Management Plan - Complete software

functional criteria and management plan for development of LLCE characterization
software.

Start: December 1, 1995
Finish: February 28, 1996

Review Cycle for Functional Criteria and Management Plan - Review and comments on
plan.

Start: February 29, 1996
Finish: March 15, 1996

Incorporate Comments from Review of Plan - Resolve and incorporate comments into

document.

Start: March 18, 1996
Finish: April 1, 1996

Sign off of Plan - Get signatures and release document.

Start: April 2, 1996
Finish: April 16, 1996

FL T T -SD-WM- -
007. REV 0

Write Pag Revision - Write page change revision to reflect current LLCE waste
characterization plan to reflect current characterization practices.

Start: 3/18/96
Finish: 4/23/96

Review - Review and comment period for revision.

Start: 4/26/96
Finish: 5/10/96

D-3



2.3

2.4

3.0

4.0

4.1

4.2

4.3

5.0
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Incorporate and disposition comments - Incorporate comments from review.

Start: 5/13/96
Finish: 5/27/96

Sign Off and Release of Revised Document - Get signatures and final release of revised

document.

Start: 5/28/96
Finish: 6/11/96

ACQUIRE SOFTWARE TOOLS - Identify and procure necessary software tools to

write software.

Start: 4/1/96
Finish: 5/1/96

TW. T
Software Coded - Write software code for programs. Generate databases.

Start: 5/13/96
Finish: 9/1/96

Debug - Debug all modules of software code.

Start: 7/10/96
Finish: 9/1/96

Testing - Test operation of software code (prior to acceptance test).

Start: 8/1/96
Finish: 9/1/96

ACCEPTANCE T PR D

Write Software Acceptance Test Procedure - Write procedure to be used to test software
for use.

Start: 8/12/96
Finish: 9/2/96
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5.2 Reviewand [ rate ents - Get review and comments on acceptance test
procedure. Incorporate comments.

Start: 9/3/96
Finish: 9/10/96

5.3 Sign Off - Get signatures and release of acceptance test procedure.

Start: 9/11/96
Finish: 9/23/96

5.4 Perform Software Acceptance Test - Perform software acceptance test according to the
acceptance test plan.

Start: 9/23/96
Finish: 9/30/96
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